Tach Facts™ provides complete race analysis on your personal computer.
Introduction

Tach-Facts V3.0 Software

Tach-Facts V3.0 is the latest upgrade from the original Tach Facts software package that has proven to be among the easiest Motorsports Data Acquisition programs to learn and understand! With additional features like logbook searching, and automatic run zeroing/synchronizing, Tach-Facts V3.0 will place you seconds ahead of your competition.

Advanced programming provides the ability to view multiple graphs for clear and concise comparison between runs. Two axis zoom enables close up analysis of targeted areas down to one hundredth of a second on both the horizontal and vertical plane for a true microview.

Run Overlay helps you overlay multiple runs and now features a choice of automatic or manual sync and zero on the graph. A compare screen is available that calculates the performance difference of each channel every one hundredth of a second. Compare can be activated and moved to the most convenient screen location for pinpoint analysis right on the graph.

The Tach-Facts V3.0 Log Book has been included with search capability. You can find runs by searching up to 16 information fields including 8 user defined fields. Using specific criteria to locate run information enables you to see results, in seconds! The runs can then be opened from the log book page with only the click of your mouse. The Log Book also gives you the ability to add previous logs, eliminating hours of time spent searching through paper logs.

Tach-Facts V3.0 is compatible with Windows 95, 98, NT, 2000 and XP.
# Table of Contents

**Installation**.................................................................4  
**Getting Started**...........................................................5  
  Window 95, 98, NT, 2000 and XP......................................5  
  Fast Download Instructions..............................................5  
  To graph the run..........................................................5  
**Main Screen**..................................................................6-13  
  Screen Appearance.......................................................6  
    *File Menu*.................................................................7,8  
    *Graphs Menu*.............................................................9  
    *Log Book Menu*..........................................................10  
    *Options Menu*............................................................11  
    *Window Menu*...........................................................12  
    *Help Menu*................................................................13  
**Icons**............................................................................14  
**Options Menu**..............................................................15-17  
  System Options............................................................15-17  
**File Menu**.................................................................18-36  
  Download Data File.......................................................18, 19  
  Open Data File 1............................................................20, 21  
  Open Data File 2............................................................22, 23  
  Print Data.......................................................................24  
  Maintenance...................................................................25-35  
    *Category Maintenance*..............................................25, 26  
    *Question Maintenance*..............................................27, 28  
    *Question Order*........................................................29, 30  
    *Range Maintenance*..................................................30, 31  
    *Channel Maintenance*...............................................32, 33  
    *User Defined Field Maintenance*...............................34, 35  
  Exit..............................................................................36  
**Graph Menu**............................................................37-57  
  Graph Selected Channels...............................................37-39  
  RPM Quick Graph - 1.....................................................40  
  RPM Quick Graph - 2.....................................................41
Graph Options........................................................................................................ 42-49
  Maximize Graph.................................................................................................. 43
  Set Axis.............................................................................................................. 44
  Show Graph Annotations.................................................................................... 45
  Grid Lines........................................................................................................... 46
  Export Picture..................................................................................................... 47, 48
  Print..................................................................................................................... 48
  Exit....................................................................................................................... 49
Run 1 (Run 2) Menu .............................................................................................. 49
Sync Menu ............................................................................................................ 50, 51
Hide Menu ............................................................................................................ 51
Reset 0 Menu ........................................................................................................ 52
Crop Menu ............................................................................................................ 53
Compare Menu ..................................................................................................... 54
Zoom Out Menu .................................................................................................... 55, 56
Quick Menu .......................................................................................................... 56
Log Menu ............................................................................................................. 57
Window Menu ...................................................................................................... 57
Helpful Tips.......................................................................................................... 58-62
  Short Cut Keys.................................................................................................... 58
  Adding Channels on the Fly.............................................................................. 59, 60
  Right Mouse Button Options........................................................................... 61, 62
Log Book Menu .................................................................................................... 63, 64
  Search Log Info.................................................................................................. 63, 65
  Log Book............................................................................................................. 65, 66
  Add Previous Logs.............................................................................................. 67
Window Menu ....................................................................................................... 68
Help Menu ............................................................................................................. 69
Quick Reference Sheet ......................................................................................... 71
Notes...................................................................................................................... 70, 72
Installation
Windows 95, 98, NT, 2000, and XP

Complete the steps below to install Tach-Facts V3.0 on your computer for Windows 95, 98, NT, 2000 and XP applications.

1. Insert the CD into the CD Rom.
   RESULT: One of the following results will occur:
   • If the set-up does not start automatically, proceed to step 2.
   • If the set-up starts automatically, proceed to step 5.

2. Double click on the My Computer icon located on the Windows desktop.

3. Double click on the designated CD Rom drive.

4. Double click on the Set-up icon. (setup.exe)

5. The welcome window will ask you if you want to install the program, click OK.

6. The Select Destination Directory window will ask for the directory to install the program in, click OK to accept the default directory which is C:\Program Files\Datafact. (It is recommended that the default directory is used.)
   RESULT: The files from the CD are loaded onto the selected drive.

7. Remove the CD from the CD Rom.

8. After the installation is complete, close the CD Rom drive window.

9. A shortcut will appear on your desktop.

Trademarks
All terms mentioned in this instruction that are known to be trademarks or service marks are listed below. In addition, terms suspected of being trademarks or service marks have been appropriately capitalized. Auto Meter Products, Inc. cannot attest to the accuracy of this information. Use of a term in this instruction should not be regarded as affecting the validity of any trademark or service mark.

Terms:
Windows 95, 98, NT, 2000 and XP are trademarks of Microsoft Corporation.
Tach-Facts is a trademark of Auto Meter Products, Inc.
Getting Started

Windows 95, 98, NT, 2000, and XP

Complete one set of steps below to run Tach-Facts V3.0 on a Windows 95, 98, NT, 2000, or XP operating system.

1. Double click the Tach-Facts icon on your desktop.
   or
1. Click START, PROGRAMS, Tach-Fact, Tach-Facts.
   or
1. If the My Computer window is not still open, double click on the My Computer icon.
2. Double click on the disk C: icon located in the My Computer window.
3. Double click on the folder labeled Program Files.
5. Double click on the Data folder.
7. If you want to create a shortcut on your desktop, Right click and hold on the Data facts icon in the Data facts folder, then drag over the desktop. When the mouse button is released, Select the “create shortcut here” option.

RESULT: The Tach-Facts Pro software is now running on your computer.

Fast Download Instructions (After recording a run):

1. With Engine off, power up the tachometer.
2. Connect a 9 pin D-Sub Straight through cable from the Tach to the Computer.
3. Press the down arrow button on tach keypad to Display Dpc# (# =1-4 depending on run recorded) on the LED indicator of the Tach.
4. Press the Enter button on Tach keypad.
5. Download run.
   A) Open TachFacts Software in your computer.
   B) From the main menu, click on the “cable” icon – or – click File, then Download Data File.
   C) Name the file and click Save. Data Flow should begin at this point.
   D) Download (copy) is complete when the “Press To Cancel” button disappears.

To graph the run

TachFacts 3.0 will automatically load the run as Run 1 upon completion of Download. To graph the run, simply press the F3 key on your computer. You can add or delete RPM or ratio lines from the graph by clicking on the values at the top of the graph.

You can also open this or any previously downloaded run by Clicking on the File folder icon(s), or by clicking on File, Open File 1 (use this for run overlay), and selecting the desired file to graph. Open File 2 is enabled after a File 1 is opened.
Main Screen

Screen Appearance
This is the main screen that will display after opening the Tach-Facts Pro software.

NOTE: No runs are listed in the windows at the bottom of the screen and no graphs are displayed.

Menus
The main screen provides you with 6 different menus:
  • File
  • Graphs
  • Log Book
  • Options
  • Window
  • Help
File Menu

Below is a list of options provided within the file menu including a brief description:

Open Data File 1 - Opens a file which was previously downloaded from the Tach.

Open Data File 2 - Opens a second file which was previously downloaded from the Tach.
**NOTE:** You must have a file open in File 1 to use File 2.

Download Data File - Downloads a run from the Tach and creates a file named by you.

Print Data - Prints text data from opened data file only.
**NOTE:** If 2 files are open, only data file 1 will print.
Main Screen, cont'd

File Menu, cont’d

Maintenance - Offers a sub-menu with the following maintenance options:

- **Category Maintenance** - Enables you to add, change or delete categories in your log book. (See page 25)

- **Question Maintenance** - Enables you to add, change or delete the questions asked in the log book. (See page 27)

- **Question Order** - Enables you to prioritize the order questions are asked in the log book. (See page 29)

- **Range Maintenance** - Enables you to update the ranges displayed in your graphs. (See page 30)

- **Channel Maintenance** - Enables you to add, change or delete channel information. (See page 32)

- **User Defined Field Maintenance** - Enables you to name or rename 8 User Defined fields in the Search Log Info feature. (See page 34)

Exit - Returns you to Windows.
Graphs Menu

Below is a list of options provided within the Graphs menu including a brief description:

<table>
<thead>
<tr>
<th>Graphs Menu</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Graph Selected Channels (F2) -</td>
<td>Enables you to graph selected channels manually. (See page 37)</td>
</tr>
<tr>
<td>RPM Quick Graph 1 (F3)-</td>
<td>Automatically creates a graph displaying Engine and Drive Shaft RPM channels plus E/D ratio for Run 1. (See page 40)</td>
</tr>
<tr>
<td>RPM Quick Graph 2 (F5)-</td>
<td>Automatically creates a graph displaying Engine and Drive Shaft RPM channels plus E/D ratio for Run 2. (See page 41)</td>
</tr>
</tbody>
</table>

NOTE: The function keys (F2 - F5) cannot be used with graph menu open.
Log Book Menu

Below is a list of options provided within the log book menu including a brief description:

**Search Log Info** - Enables you to search and view logged information from previous runs.
(See page 63)

**Log Book** - Accesses the log book for the open run.
(See page 65)
**NOTE:** A run must be opened first before using this feature.

**Add Previous Logs** - Enables you to add run information from your previous log books and utilize the Search Log Info feature. (If the run is not downloaded from the Data Logger, the graph feature will not be available).
(See page 67)
Options Menu
Below is a list of options provided within the options menu including a brief description:

System Options - Enables you to customize Tach-Facts Pro V3.0 to your specific wants or needs. (See page 15)
**Main Screen, cont’d**

**Window Menu**

Below is a list of options provided to show opened log book pages within the Window menu including a brief description:

- **Cascade** - Used to arrange multiple log book pages.
- **Tile Horizontally** - Used to arrange multiple log book pages.
- **Tile Vertically** - Used to arrange multiple log book pages.
- **Arrange Icons** - Not implemented in this version of software.
- **Close All Windows** - Closes all of the open windows in the log book feature.
Help Menu

Below is a list of options provided within the help menu including a brief description:

About Tach-Facts -  Shows software version for 5 seconds.
Icons

Below is a list of Icons provided on the main screen in order for you to execute a specific function more quickly.

Open Data File 1 - Refer to pages 20-21 for more detail.

Open Data File 2 - Refer to pages 22-23.

Download Data File - Refer to pages 18-19.

Print Data - Refer to page 24.

Graph Selected Channels - Refer to pages 37-39.

RPM Quick Graph - Refer to page 40-41.

Log Book - Refer to pages 65-66.

Search Log Info. - Refer to pages 63-66.

Switch Autoscale Mode - Refer to page 17.
Options Menu

This function enables you to set-up system configuration.

System Options

This function allows you to customize Tach-Facts Pro to your specific needs for downloading and graphing.

1. Click on the **Options** menu.
2. Click on **System Options**.

RESULT: The System Options dialog box will open.

![System Options Dialog Box](image-url)
Options Menu, cont'd

System Options, cont'd
The functions listed below are provided within the System Options sub-menu.

Comm Port - Assigns the serial port on the computer that is used for downloading files. The system defaults to Comm Port 1.

Baud Rate - Select the baud rate that matches the download device you are using: Ultimate and Ultimate II Tachs; 9600. The system defaults to 9600.

Plot Type - Enables you to change the points and lines used for the graph. The system defaults to Line.

Graph Annotations - Enables you to mark annotations on your graph if the timeslip information is entered in the Log Book. It is recommended that 60 ET, 330 ET, 660 ET, 1000 ET and 1320 ET are checked √.

Page Up/Page Down - Enables you to change the direction of the vertical bar on the graph when using the Page Up or Page Down, or up and down arrow keys. When using the page up or page down keys, the vertical bar moves .2 second. The system defaults to Left / Right.

Plot Style - Enables you to change the thickness of the graphed lines to small, medium or large. The system defaults to medium.

First Reading - Not implemented in this version.

Print Style - Depending on the printer you have connected to your computer you can select either a color printer (this will print the same colors you see on your display) or monochrome with symbols (dot matrix, laser, or a non color printer).
System Options, cont'd

Print Samples Per Second - Enables you to print the actual data from the stored run in 10, 25, 50 or 100 samples per second to your printer.

Profile Order - Not recommended

Use Error Correction - This feature will help filter out some noise on the different channels when this feature is checked √.

Auto Load Runs - Automatically opens the data file when downloading. It is recommended that this feature is checked √.

Auto Reset 0 - Automatically resets the first drive shaft movement on the graph to 0 seconds. It is recommended that this feature is checked √.

Auto Sync - Automatically aligns the graph based on the first drive shaft reading when comparing 2 graphs. It is recommended that this feature is checked √.

Automatic Run Numbers - Not implemented in this version.

Compare Always On Top - This feature is utilized when comparing 2 graphs. The compare window always remains on top of the graph window, enabling you to move the compare window to suit your needs. It is recommended that this feature is checked √.

Overlap Axis- Enables you to use single screen or split screen options.

Automatic Scaling- Sets axis depending on data shown. Computer will determine scaling of graph.
File Menu

Download Data File
Follow the steps below to download a run from the Playback Tach at anytime.

1. Click on one of the following:
   • The File menu, then proceed to Step 2.
   • Click on the **Download Data File** icon and proceed to Step 3.

2. Click on **Download Data File**.

RESULT: The Save As dialog box appears:
Download Data File, cont’d

3. Enter the File Name for the run in the text field.
   • You may store your data in any directory on any drive, however the system defaults to C:\Program Files\Datafact\data.
   • The .TTD extension is the only extension Tach-Facts V3.0 will recognize.
   • You do not have to add this extension to your file names, it is added automatically.
   • You must conform to standard Windows naming conventions when naming your files.

   **Suggestions for naming files:**
   • 0808991.TTD - This run occurred on 08/08/99 and was the 1st run on the track.
   • GVQ198.TTD - This run was a Gainesville qualifying 1st run in 1998.

   **RESULT:**
   • The Press Button To Cancel Download dialog box appears. If you want to cancel the download, click **cancel**.

   ![Press Button To Cancel Download](image)

   **File is ready for Downloading**
   • The bottom left corner of the screen will display awaiting download.
   • Next, start the download at the Tach. See Instructions in the operating manual.
   • As data transfers into the file a rising sequence of numbers will occur.
   • The system automatically returns you to the main screen once the download is complete. If the Auto Load Run option is selected (which can be found in system options. See pages 15 - 17, the run is automatically opened and the file name displays in the bottom left corner of the screen.

   **NOTE:** Follow the steps on pages 37-57 to graph data files.
File Menu, cont’d

Open Data File 1

Follow the steps below to open a data file.

1. Click on one of the following:
   • The File menu, then proceed to Step 2.
   • Click on the Open Data File 1 icon and proceed to Step 3.

2. Click on Open Data File 1.

RESULT: The Select Data File To Load dialog box appears.
Open Data File 1, cont’d

3. Select a file name from the list provided by highlighting the name then clicking **OK** or double clicking on the file name.

**RESULT:** • The Reading Data Records dialog box appears.

When the system is finished reading the data, the dialog box will disappear. The file name will appear in the bottom left corner of your screen.

NOTE: Follow the steps on pages 37-57 to graph data files.
File Menu, cont’d

Open Data File 2

Follow the steps below to open a second downloaded data file.

1. Click on one of the following:
   • The File menu, then proceed to Step 2.
   • Click on the Open Data File 2 icon and proceed to Step 3.

2. Click on Open Data File 2.

RESULT: The Select Data File To Load dialog box appears:
Open Data File 2, cont’d

3. Select a file name from the list provided by highlighting the name then clicking OK or double clicking on the file name.

RESULT: • The Reading Data Records dialog box appears.

• When the system is finished reading the data, the dialog box will disappear. The file name will appear in the bottom left corner of your screen, next to the first file name.

NOTE: Follow the steps on pages 37-57 to graph data files.
File Menu, cont'd

Print Data

Follow the steps below to print the text data from an opened data file:

1. Click on one of the following:
   • The File menu, then proceed to Step 2.
   • Click on the Print icon.

2. Click on Print Data.

Note: The text Data is in code and is not readily usable for the average range.
Maintenance
There are several maintenance options provided within the Maintenance sub-menu.

Category Maintenance
Follow the steps below to add, change or delete the categories available in your log book:

1. Click on the File menu.
2. Move the pointer to Maintenance.
3. Click on Category Maintenance.

RESULT:
The Category Maintenance dialog box appears.
Category Maintenance, cont’d

4. Click on Prev or Next to view previously entered categories.
5. Click on Update to change a previously entered category.
6. Click on Add to save the category.
7. In the Category field, type the name of the category you want to add, change or delete.
8. In the Description field, type a brief description of the category (optional).
9. Click on Clear to erase typed information.
10. Click on Delete to eliminate a category from the log book.
11. After you are done performing category maintenance, click on Exit.
Question Maintenance

Follow the Steps below to add, change or delete the questions asked in the log book; for each category.

1. Click on the File menu.
2. Move the pointer to Maintenance.
3. Click on Question Maintenance.

RESULT: The Question Maintenance dialog box appears.
Question Maintenance, cont’d

4. In the Category field, select one of the following:
   • Click on the pull down arrow then select the category you want to edit, or type the name of the category you want to add, change or delete.
   • Typing the first letter of the category will take you to a list that matches that character. Typing it again will take you to the next matching category, providing that there is more than one match for that character or type a different letter and start over again. You can also view the category list by clicking Next or Prev.

5. In the Question field, type the question you want to add, change or delete. (When typing in the question you wish to add, keep in mind that only the first portion can be viewed).

6. If you want to change the order that the question is asked in the log book, refer to Question Order on pages 31 and 32.

7. Click on Add to add the question to the log book.

8. Click on Prev or Next to view previously entered questions.
   • If no questions have been added to a category, use the pull down arrow to find that category.

9. Click on Update to change the question or the order it is asked.

10. Click on Clear to erase typed information.

11. Click on Delete to remove the question from the log book.

12. After you are done performing question maintenance, click on Exit.

Note: This is important! Taking some time for a little preparation on question size is recommended. There is only a limited amount of space while viewing the Log Book, so abbreviating is very important.
Question Order

Follow the steps below to alter the order of the questions asked in the log book:

1. Click on the **File** menu.
2. Click on **Maintenance**.
3. Click on **Question Order**.

RESULT: The Set Question Order dialog box appears.
Question Order, cont’d
4. Using the up or down arrows, scroll through the list of questions until you find the questions you want to change, and click once on that question.
5. Click on the **Down** or **Up** icon until the order of the question has changed to what you want.
6. Click **OK** and then click **Exit** to accept the changes or **Exit** to return to the main screen without saving the changes.

Range Maintenance
Follow the steps below to change the ranges of the information displayed on your graphs which enables you to customize the size of the graph that displays on your screen:

1. Click on the **File** menu.
2. Click on **Maintenance**.
3. Click on **Range Maintenance**.

RESULT: The Password dialog box appears.

4. No password is required. Click **OK** to logon as a user.
Range Maintenance, cont’d

RESULT: One of four of the following Range Maintenance dialog boxes appears.

5. In the Min Range field, type the minimum range.
6. In the Max Range field, type the maximum range.
7. Click on Prev or Next to view previously entered ranges.
8. **Update** must be clicked to change a previously entered range.
9. After **Update** has been chosen, click on **Exit** to return to the main screen.

**NOTE:** The add, clear and delete functions are not implemented.
File Menu, cont'd

Channel Maintenance
Follow the steps below to add, change or delete channel information:

1. Click on the **File** menu.
2. Click on **Maintenance**.
3. Click on **Channel Maintenance**.

RESULT: The Password dialog box appears.

4. No password is required. Click **OK** to logon as a user.
Channel Maintenance, cont’d

RESULT: The Channel Maintenance dialog box appears.

5. Click on Prev, Next, or select the ... for the drop down box to view the different channels.

6. Range Name: By using the pull down arrow you can change where the channel is graphed on the screen. This enables you to customize the split screen.

7. Alias: Enables you to change the name of the selected channel.


9. Modifier: This is the channel math function. The signal can be modified for each channel.

10. Value: This is the value you want to modify with.

11. Units: Use the pulldown arrow to change the units.

12. Virtual and Vs Virtual are not implemented in this version.

13. First reading is not implemented in this version.

14. Acceleration is not implemented in this version.

15. Error Correction: Enables you to customize your graph scale for each channel. When manual scaling is used.

16. Click on Update to save any changes.

17. Click on Exit to return to the main screen.

NOTE: The add, clear, calibration, and delete functions are not implemented in this version.
**File Menu, cont’d**

**User Defined Field Maintenance**

This is an excellent feature which enables you to narrow your searches for log book information. Follow the steps below to name or rename the 8 user defined fields, used in the Search Log Info feature:

1. Click on the **File** menu.
2. Move the pointer to **Maintenance**.
3. Click on **User Defined Field Maintenance**.

**RESULT:** The User Defined field Maintenance dialog box appears.
User Defined Field Maintenance, cont’d

4. Select the **User Defined** field you want to name or rename by checking the box.

5. In the text field, type a title for the User Defined Field.

**NOTE:** Fields 1 through 4 require a numeric title such as reaction time, air temperature, car number, etc. Fields 5 through 8 require an alpha title such as car name, track lane, etc.

6. Click on **Save** to save the changes or **Exit** to return to the main screen without saving the changes.
Exit
Follow the steps below to close Tach-Facts and return to Windows.

1. Click on the **File** menu.
2. Click on **Exit**.

RESULT:
The Exit dialog box appears.

3. Click **Yes** to exit or **No** to return to the main screen.
Graph Menu

Once a file is opened (See page 17 or 20), a graph can be created from the data. You may choose to manually or automatically load graphs onto the screen.

Graph Selected Channels

This function enables you to manually choose specific channels you want to graph. Follow the steps below to graph selected channels.

1. Click on one of the following:
   - The Graphs menu, then proceed to Step 2.
   - Press F2, then proceed to Step 3.
   - The Graph Records icon and proceed to Step 3.

2. Click on Graph Selected Channels.

![Graph Menu]

![Graph Menu]

![Graph Menu]
Graph Menu, cont'd

Graph Selected Channels, cont'd

RESULT: The Select Channels To Graph dialog box appears. If only one run or file is opened, the dialog box below appears:

If two runs or files are opened, the dialog box below appears:
Graph Selected Channels, cont'd

3. Click on **1 - Engine RPM**.
4. Click the **Add >>** button or double click on **1 - Engine RPM**.
   
   **RESULT:** The 1 - Engine RPM channel will move from the Available Channels column to the Channels to Graph column.

5. Add additional channels you wish to activate for the graph.
6. If 2 runs are opened, click on **2 - Engine RPM**.
7. Click the second **Add >>** button or double click on **2 - Engine RPM**.
   
   **RESULT:** The 2 - Engine RPM channel will move from the Available Channels column to the Channels to Graph column.

8. Add additional channels you wish to activate for the second run.
9. After the channels are selected, click on one of the following:
   • **Graph icon** - displays graph
RPM Quick Graph - 1
This function automatically graphs the following channels for run 1:
- 1 - Engine RPM
- 1 - Drive RPM
- 1 - E/D Ratio

Follow the steps below to create a RPM Quick Graph for run 1.

1. Press F3 or click on one of the following:
   - The RPM Quick Graph icon.
   - The Graphs menu, then proceed to step 2.

2. Click on RPM Quick Graph - 1.

RESULT: The Select Channels to Graph dialog box appears momentarily, then the graph appears.
RPM Quick Graph - 2

(Note: A file must be open in Run 2.)

This function automatically graphs the following channels for Run 2:
- 2 - Engine RPM
- 2 - Input Shaft
- 2 - Drive RPM

Follow the steps below to create a RPM Quick Graph for run 2.

1. Select one of the following:
   - Click on the **Graphs** menu, then proceed to step 2.
   - Press F5.
2. Click on RPM Quick Graph - 2.

RESULT: The Select Channels to Graph dialog box appears momentarily, then the graph appears.
Graph Menu, cont'd

Graph Options

After a graph is created, the following menu options are available:
Maximizing a Graph

Follow the steps below to maximize a graph:

1. Select one of the following:
   - Click on the Graph menu, then proceed to step 2.
   - Press the ‘M’ key, then proceed to step 3.
2. Click on Maximize Graph.

RESULT: An enlarged view of the graph appears:

3. Click on the title bar or press the ESC key to return the graph to its original size.
Graph Menu, cont’d

Set Axis

(Note: Autoscale must be disabled. See page 15.)

This feature enables you to change the range of the displayed channels. Follow the steps below to set the axis:
1. Click on the Graph menu.
2. Click on Set Axis.

RESULT: The information displayed on the graph will appear in the Set Temporary Axis dialog box.

3. Type the starting and ending values.
4. If the Make Changes Permanent box is checked √, the changes will become the new default.
5. Click OK to save the changes or Exit to return to the graph without saving the changes.
Graph Menu, cont’d

Showing Graph Annotations
(Must be enabled in Option/System Options P. 16)
If the timeslip information is entered into the Log Book, this feature enables you to view the marked annotations on the graph. Follow the steps below to show or remove graph annotations: (A check mark will appear if Show Graph Annotations is turned on.)

1. Select one of the following:
   • Click on the **Graph** menu, then proceed to step 2.
   • Press and hold both the **Control** key and the ‘A’ key.
2. Click on **Show Graph Annotations**.

RESULT: The annotations are displayed on the graph.

NOTE: To enable this feature automatically, refer to System Options, Graph Annotations on page 16.
Graph Menu, cont’d

**Grid Lines**

Follow the steps below to change the grid lines displayed in the graph:

1. Click on the **Graph** menu.
2. Move the pointer to **Grid Lines**.
3. Click on one of the following, depending on what you want:
   - **No Grid Lines**
   - **Horizontal Grid Lines**
   - **Vertical Grid Lines**
   - **Both Grid Lines**
Exporting a Picture

This feature enables you to export the graph into a different application. The export feature is designed for the advanced Windows user.

Follow the steps below to export the graph:
1. Click on the Graph menu.
2. Click on Export Picture.

RESULT: The Exporting dialog box appears.

3. Select the file format you want to save the graph as:
   - MetaFile
   - BitMap
   - Text/Data Only
Exporting a Picture, cont’d

4. Select the Export Destination:
   • ClipBoard - Moves the graph to your desktop.
   • File - Saves the graph as a file for later use.
   • Printer - Opens the Windows Print dialog box. Click OK to print or Cancel to exit without printing.

5. Select the Object Size:
   • No Specific Size
   • Millimeters
   • Inches
   • Points

6. Click on Export to export the graph or Cancel to return to the graph.

Print

Follow the steps below to print the graph:
1. Click on the Graph menu.
2. Click on Print.
Exit

Follow the steps below to return to the Main Screen:
1. Click on the Graph menu.
2. Click on Exit.

RESULT: The Main Screen appears.

Run 1 (Run 2) Menu

This feature enables you to toggle between information for Run 1 and Run 2. Two runs must be opened to utilize this feature. Follow the step below to toggle between runs.

1. Click on one of the following:
   • Run 1 - To view information from Run 1.
   • Run 2 - To view information from Run 2.
Sync Menu
This feature enables you to synchronize two runs automatically or manually. When two runs are synchronized, they start at the exact same position, making it easier for you to compare the runs. Refer to page 17 to set Auto Sync as the system default.

Follow the steps below to synchronize two runs, based on the first drive shaft movement:

**Auto Sync**
1. Click on the Sync menu.
2. Click on **Auto Sync**.

RESULT: The runs are synchronized based on the first drive shaft movement.

**Manual Sync**
1. Move the vertical bar to the start of Run 1.
2. Click on the Sync menu.
3. Move the pointer to **Manual Sync**.
4. Click on **Set Start of Run 1**.

RESULT: The Tachfact dialog box appears.

3. Click **OK**
4. Move the vertical bar to the start of Run 2.
5. Click on the **Sync** menu.
6. Move the pointer to **Manual Sync**.
Graph Menu, cont’d

Sync Menu, cont’d

7. Click on **Set Start of Run 2**.

RESULT: The Tachfact dialog box appears.

8. Click on the **Sync** menu.
6. Move the pointer to **Manual Sync**.
7. Click on **Synchronize**.

Hide (Show) Menu

Follow the steps below to hide run information and expand the graph or show run information and decrease the size of the graph:

1. Click on the **Hide** menu to hide the run information.
2. Click on the **Show** menu to view the run information.
Reset 0 Menu

This feature enables you to reset the time index, matching it to the first drive shaft movement or any position on the graph. Refer to page 17 to set Auto Reset 0 as the system default. Follow the steps below to reset the time index automatically or manually:

**Automatic Reset**
1. Click on the Reset 0 menu.
2. Click on **Automatic Reset**.
Crop Menu
This feature enables you to remove the left or right portion of the graph temporarily. You can crop the graph as many times as you want.

Follow the steps below to crop information:

**Crop Left**
1. Set the vertical bar to the desired position.
2. Click on the Crop menu.
3. Click on Crop Left.

**NOTE:** Synchronized graphs will become unsynchronized when the graph is cropped, unless the Auto Sync feature is enabled, refer to page 17.

**Crop Right**
1. Set the vertical bar to the desired position.
2. Click on the Crop menu.
3. Click on Crop Right.

**NOTE:** Synchronized graphs will become unsynchronized when the graph is cropped, unless the Auto Sync feature is enabled, refer to page 17.
Graph Menu, cont'd

Compare Menu
This is an excellent feature that enables you to compare run information when 2 runs are loaded.

Follow the steps below to compare run information:
1. Click on the Compare menu.

   **RESULT:** The Compare Data window appears.

   ![Compare Data Window](image)

   **NOTE:** The Compare Data window can be moved by selecting the window and dragging it to the desired area on the graph.

2. Click on an unselected channel in the run information to add that channel to the graph.

   **RESULT:** The channel is highlighted and displayed on the graph.

3. Click on a highlighted channel in the run information to remove that channel from the graph.

   **RESULT:** The channel is removed from the graph and no longer highlighted.
Zoom Out Menu

Follow the steps below to zoom in on a selected area of the graph:
1. Set the pointer to the area you want to zoom.
2. Press and hold the following keys:
   • Shift key.
   • Left mouse button.
3. Drag the mouse to the desired zoom window.
4. Release the shift key and mouse button.

RESULT: The selected area is displayed.

NOTE: You may zoom in as many times as you want.
Graph Menu, cont'd

Zoom Out Menu, cont’d
Follow the steps below to zoom out, resetting the graph to its original size:
1. Click on one of the following:
   • Click on Zoom Out.
   • Press the ‘Z’ key.

RESULT: The graph returns to its original size.

Quick Menu
Follow the steps below to view different channel selections more quickly:
1. Click on the Quick menu.
2. Click on one of the different channel selections.

RESULT: The current graph disappears and your channel selection appears.
Log Menu

Follow the steps below to display the Log book for the current run:
1. Click on the Log menu.

RESULT: The Log book - (run number) dialog box appears.

2. Refer to pages 63-64 for complete features for the Log Book.

Window Menu

Displays the file name of the current run displayed.
Helpful Tips

Shortcut Keys

The following keys, on your keyboard, enable you to utilize specific features more quickly while viewing a graph:

- M - Maximize Graph. Refer to page 43 for more details.
- Z - Zoom Out. Refer to pages 55-56.
- P - Print. Refer to page 48.
- Q - Displays right mouse button options. Refer to pages 61-62.
- CTRL+A - Shows annotations, if the timeslip information is entered into the Log Book. Refer to page 45.

The following shortcut keys can be utilized from the Main Screen:

- CTRL+I - Displays the Log Book Entries dialog box for searching. Refer to pages 63-65.
- CTRL+L - Displays the Log Book. Refer to pages 65-66.
- CTRL+P - Displays the Previous Log Book Entry for adding logs. Refer to page 67.

The following shortcut keys can be utilized from both the Main Screen and while viewing a graph:

- F2 - Graph Selected Channels. Refer to pages 37-39.
- F3 - RPM Quick Graph 1. Refer to page 40.
- F5 - RPM Quick Graph 2. Refer to page 41.
Adding Channels on the Fly
Follow the steps below to add or remove the channels displayed on the graph:

1. Click on an unselected channel in the run information to add that channel to the graph.

RESULT: The channel is highlighted and displayed on the graph.
Helpful Tips, cont’d

Adding Channels on the Fly, cont’d

2. Click on a highlighted channel in the run information to remove that channel from the graph.

RESULT: The channel is removed from the graph and no longer highlighted.
Right Mouse Button Options

When a graph is opened, clicking the right mouse button displays the following options:

<table>
<thead>
<tr>
<th>Viewing Style -</th>
<th>Selects the number of colors used when viewing a graph.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font Size -</td>
<td>Selects the size of the font used when viewing a graph.</td>
</tr>
<tr>
<td>Numeric Precision -</td>
<td>Determines how precise the measurements are on the graph.</td>
</tr>
<tr>
<td>Plotting Method -</td>
<td>Changes the appearance type of line displayed in the graph.</td>
</tr>
</tbody>
</table>

- Viewing Style -
  - Color
  - Monochrome
  - Monochrome + Symbol

- Font Size -
  - No decimals
  - 1 Decimal
  - 2 Decimals
  - 3 Decimals

- Numeric Precision -
  - No decimals
  - 1 Decimal
  - 2 Decimals
  - 3 Decimals

- Plotting Method -
  - Point
  - Line
  - Points + Best Fit Line
  - Points + Best Fit Curve
  - Points + Line
  - Points + Spline
  - Spline
Helpful Tips, cont’d

Right Mouse Button Options, cont’d

*Data Shadows* - Not implemented in this version of software.
*Grid Lines* - Changes the appearance of the grid when viewing a graph.
*Grid In Front* - Moves the grid lines in front of the data on a graph.
*Mark Data Points* - This feature shows the exact points of data on the graph.
*Show Annotations* - Marks the annotations on the graph. See page 45 for further information.
*Undo Zoom* - Resets the graph to its original size after the zoom in feature is utilized. See pages 55 and 56 for further information.
*Maximize* - Hides the run information and expands the graph on the screen. See page 43 for further information.
*Export Dialog* - Enables you to export the graph in a different application. See pages 47 and 48 for further information.
*Help* - Not implemented in this version of software.
Log Book Menu

This is an excellent feature which enables you to do the following:
• Store and retrieve racing information.
• Import existing log information into the data base.
• Search the logs by categories such as corrected altitude, E.T.’s, MPH, track location, date and much more.

Search Log Info

Follow the steps below to search log information:
1. Click on the Log Book menu.
2. Click on Search Log Info.

RESULT: The Log Book Entries dialog box appears.
Log Book, cont'd

Search Log Info, cont’d

3. Click on the *Eye* icon to search through the log book entries. 

RESULT: The Log Book Query window appears.

4. Input the criteria you would like to search by. For example, search all the runs with a corrected altitude between 1500' and 2000' by entering the information in the Corr Altitude Range field.
Search Log Info, cont’d

5. Click on OK to begin the search.

RESULT: The runs that met the search criteria appear.

6. Click on one of the following:
   • Double click on the listed run(s) to open the Log Book. See page 10 for further information.
   • Click on the Search icon to search again.
   • Click on the Refresh icon to view the complete Log Book entry pages.
   • Click on the Exit icon to return to the Main Screen.

Log Book

Follow the steps below to view the Log Book for the opened run:
1. Click on the Log Book menu.
2. Click on Log Book.

RESULT: The Log Book window appears.
Log Book, cont'd

Log Book, cont’d

NOTE: If two runs are opened, select Run 2 on the toolbar, to view the Log Book for that run.

3. If you are entering a new log, input the Run Name and all of the run information in the appropriate fields.

4. Click on one of the following icons:

   • Load - Enables you to open the run from the Log Book window.
   • OK - Saves a new log entry.
   • Import - Imports run information from a previous Log Book entry.
   • Delete - Deletes the Log book entry.
   • Exit - Returns you to the Main Screen without saving changes.
Add Previous Logs

Follow the steps below to add run information from your previous log books:
1. Click on the Log book menu.
2. Click on Add Previous Logs.

RESULT: The Previous Log Book Entry window appears.

3. Input the Run Name and all of the run information in the appropriate fields.
4. Click on one of the following icons:
   - Load - Enables you to open the run from the Log Book window.
   - OK - Saves a new log entry.
   - Import - Imports run information from a previous Log Book entry.
   - Delete - Deletes the Log book entry.
   - Exit - Returns you to the Main Screen without saving changes.
Window Menu

The options listed below are provided within the Window menu:

- **Cascade** - Used to arrange multiple log books.
- **Tile Horizontally** - Used to arrange multiple log books.
- **Tile Vertically** - Used to arrange multiple log books.
- **Arrange Icons** - Not implemented in this version of software.
- **Close All Windows** - Closes all of the open windows in the log book feature.
Help Menu

The options listed below are provided within the help menu:

**About Tach-Facts** - Displays your name, address, city, state, zip and the software version number for 5 seconds.

**Search For** - Not implemented in this version.

**Contents** - Not implemented in this version.

**Errors**
If an error occurs, simply close and restart the program. If the problem persists, contact Auto Meter Products for further help.
Quick Reference Sheet

F2 ............................................................... Graph Selected channels
F3 ............................................................... RPM Quick Graph - 1
F5 ............................................................... RPM Quick Graph - 2
Ctrl+I ......................................................... Search Log Info
Ctrl+L ......................................................... Log Book
Ctrl+P ......................................................... Add Previous Logs

Icons

Below is a list of Icons provided on the main screen in order for you to execute a specific function more quickly.

Open Data File 1 - Refer to pages 20-21 for more detail.

Open Data File 2 - Refer to pages 22-23.

Download Data File - Refer to pages 18-19.

Print Data - Refer to page 24.

Graph Selected Channels - Refer to pages 37-39.

RPM Quick Graph - Refer to page 40-41.

Log Book - Refer to pages 65-66.

Search Log Info. - Refer to pages 63-66.

Switch Autoscale Mode - Refer to page 17.